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R-IN32M3 Series 
EtherNet/IP Transfer Procedure Startup Manual 

Outline 
This manual explains the procedure for connecting a CODESYS software programmable logic controller 
(PLC) with the Renesas Electronics R-IN32M3-EC evaluation board to enable EtherNet/IP™ transfer. 

The R-IN32M3 EtherNet/IP stack sample program in this package (“sample program”) runs on the Arm® 
Cortex®-M3 core. Its configuration is intended for those who wish to start developing EtherNet/IP devices 
with products of the R-IN32M3 series. 

For details of the functions of the program, you can separately download the relevant documents from the 
Renesas Electronics website. 

 

Target Devices 
R-IN32M3 Series 

 

Sample Program 
This sample program uses the evaluation version of EtherNet/IP stack manufactured by our partner Sherpa 
Inc. 

For purchase of the official version, contact our partner Sherpa Inc. 

Sherpa Inc. : https://www.sherpa-tech.net/ 

 

  

R01AN4281EJ0100 
Rev.1.00 

May. 25, 2018 

https://www.sherpa-tech.net/


R-IN32M3 Series EtherNet/IP Transfer Procedure Startup Manual 

R01AN4281EJ0100  Rev.1.00  Page 2 of 34 
May. 25, 2018  

 

Contents 

1. Operating Environment .................................................................................................. 3 

2. Setting up and Connecting the R-IN32M3-EC Evaluation Board ................................. 4 
2.1 Setting up the R-IN32M3-EC Evaluation Board ........................................................................ 4 
2.2 Settings to Start the R-IN32M3-EC Board ................................................................................. 5 
2.3 Connecting the R-IN32M3-EC Evaluation Board ...................................................................... 5 

3. Starting the R-IN32M3 EtherNet/IP Stack Sample Program ......................................... 6 
3.1 Starting and Building a Project.................................................................................................. 6 
3.2 Starting the Program .................................................................................................................. 9 

4. Confirming Transfer to and from CODESYS .............................................................. 10 
4.1 Starting CODESYS .................................................................................................................... 10 
4.2 Updating the Slave Device ....................................................................................................... 11 

4.2.1 Installing Device Information ............................................................................................. 11 
4.2.2 Updating the Devices ......................................................................................................... 13 

4.3 Connecting to the Software PLC ............................................................................................. 17 
4.3.1 Starting the Gateway Server .............................................................................................. 17 
4.3.2 Starting the Software PLC .................................................................................................. 18 
4.3.3 Setting up Connection with the Software PLC ................................................................ 19 

4.4 Network Settings for Devices .................................................................................................. 20 
4.4.1 Configuring the Host IP Address ...................................................................................... 20 
4.4.2 Configuring the Ethernet Link ........................................................................................... 22 
4.4.3 Configuring EtherNet_IP_Scanner .................................................................................... 23 
4.4.4 Configuring EIPS_DEMO_RIN32M3 .................................................................................. 23 

4.5 Confirming the Connection with the Device .......................................................................... 24 
4.6 Operations of CODESYS .......................................................................................................... 26 

5. Documents for Reference ............................................................................................ 27 

Appendix A  Changing the Configuration of the R-IN32M3-EC Evaluation Board .......... 28 
A-1 System Configuration ............................................................................................................... 28 
A-2 Changing the Configuration ..................................................................................................... 29 

A-2-1 Connecting the R-IN32M3-EC Evaluation Board ............................................................. 29 
A-2-2 Changing the Configuration .............................................................................................. 29 

Appendix B  Notes on the Sample Program ...................................................................... 33 
 



R-IN32M3 Series EtherNet/IP Transfer Procedure Startup Manual 

R01AN4281EJ0100  Rev.1.00  Page 3 of 34 
May. 25, 2018  

1. Operating Environment 
The sample program covered in this manual runs in the environment below. 

 

Table 1.1 Operating Environment 
Item Description 

Board used R-IN32M3-EC evaluation board 
 TS-R-IN32M3-EC 

MCU R-IN32M3 
Operating frequency 100 MHz 
Operating voltage 3.3 V 
Operating mode • Boot from the instruction RAM. 

• Boot from the external serial flash ROM. 
Device used Serial flash memory 

S25FL032P0XNFI010 from Spansion 
Communications protocol EtherNet/IP 
Integrated development 
environment 

Embedded Workbench for Arm version 7.80 from IAR Systems 

Emulator I-jet from IAR Systems 

Software PLC CODESYS V3.5 SP11 from 3S-Systems GmbH 

 

Note: This manual assumes that you have installed the IDE and software PLC. 

The software PLC is available from the Linx website (http://linx.jp/download/codesysv3). 
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2. Setting up and Connecting the R-IN32M3-EC Evaluation Board 
For detailed information on the board, refer to the TS-R-IN32M3-EC-E User’s Manual, which is available at 
the following link. 

http://www.tessera.co.jp/eng/ts-r-in32m3-e.html 

 

2.1 Setting up the R-IN32M3-EC Evaluation Board 
Before supplying power, set up the DIP switches and jumpers and connect the cables. The figure below 
shows the locations of the related parts. 

 

Figure 2.1 Parts to Set up and the Locations for Cable Connections 
 

 

  

R-IN32M3-EC Evaluation Board 

ICE* 

JTAG 

 

CN16 

The asterisks (*) indicate the devices that the user needs to prepare. 

Ethernet Serial 

Host PC* 

• Embedded Workbench 
 for Arm version 7.80 

• CODESYS V3.5 SP11 

  
MODE_SW 

R-IN32M3 

http://www.tessera.co.jp/eng/ts-r-in32m3-e.html
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2.2 Settings to Start the R-IN32M3-EC Board 

The levels on external pins (BOOT0 and BOOT1) of the R-IN32M3 series device select the source from 

which the board is to be booted up. The boot mode for the R-IN32M3-EC evaluation board is selected by the 
setting of MODE_SW (SW1). 

The setting should be made before connecting an DC adapter to supply 5 V at up to 3 A. 

 
Table 2.1 Operating Mode Selection 

MODE_SW (SW1) 
Boot Mode Selection 

1 2 

ON (High) ON (High) Booting is from the instruction RAM (only usable for debugging). 

OFF (Low） ON (High） Booting is from the external MCU. 

ON (High) OFF (Low) Booting is from the external serial flash ROM. 

OFF (Low) OFF (Low) Booting is from the external parallel flash ROM. 
 

 

 

2.3 Connecting the R-IN32M3-EC Evaluation Board 
Connect the cables as described below. 

(1) Connect the Ethernet cable (category 5 is recommended) to CN16. 

(2) Connect the JTAG connector for ICE (I-jet) to CN1 (ARM JTAG20) to connect the host computer over the 
USB. 

(3) Connect an AC adapter with DC 5 V output to CN15 to supply power. 

 

 

  

R-IN32M3-EC Evaluation Board 

 

CN16 

■ Setting for booting from the instruction RAM 
(MODE_SW(SW1[1:8])) 

Serial 

  
MODE_SW 

R-IN32M3 
■ Setting for booting from the external serial flash 

ROM (MODE_SW(SW1[1:8])) 

TS-R-IN32M3-EC 

ON  ■■□□□□□□ 

OFF □□■■■■■■ 

TS-R-IN32M3-EC 

ON  ■□□□□□□□ 

OFF □■■■■■■■ 
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3. Starting the R-IN32M3 EtherNet/IP Stack Sample Program 
 

3.1 Starting and Building a Project 
(1) From the Windows Start menu, click on [All Programs] → [IAR Systems] → [IAR Embedded Workbench 

for ARM x.xx] → [IAR Embedded Workbench] to start the IAR Embedded Workbench. 
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(2) Select [File] → [Open] → [Workspace] and double-click on the “rin32m3_ethernetip.eww” filename in ¥an-

r01an4281ej0100_rin32m3_ethernetip¥R-IN32M3_ETHERNETIP_sample to open the workspace. 

 

 
 

  

(3) Select the build setting from the following two types (“Debug” and “Release”). 

[For execution from the internal RAM (iRAM) of R-IN32M3 from the ICE] 

If you selected booting from the instruction RAM in section 2.2, Settings to Start the R-IN32M3-EC Board, 
select “Debug”. 

 
[For booting from the external serial flash ROM of R-IN32M3 from the ICE] 
If you selected booting from the external serial flash ROM in section 2.2, Settings to Start the R-IN32M3-EC 
Board, select “Release”. 
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(4) Select [Project] → [Rebuild All] to run a build. 
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3.2 Starting the Program 
Select [Project] → [Download and Debug] to download the program to the target. Click on the [Go] button to 
start the program. 
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4. Confirming Transfer to and from CODESYS 
 

4.1 Starting CODESYS 
(1) From the Windows Start menu, select [All Programs] > 3S CODESYS > CODESYS > CODESYS Vx.x 

(x.x represents the version number). You can also start the program by double-clicking on the CODESYS 
icon, which will be created after the installation of the program. 

 

(2) Click on [File] → [Open Project …] and double-click on the “Renesas_R-IN32M3_EtherNetIP.project” 
filename in ¥an-r01an4281ej0100_rin32m3_ethernetip¥ to open the project. 

 

Regarding the procedures for building new CODESYS projects and for creating and simulating a user 
interface, refer to the R-IN, RZ/T1, EC-1, TPS-1 Groups Software PLC Guide: Configuring Projects and 
Creating User Interfaces. 
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(3) When the project is started, the “Devices” tree will be displayed. 

  

 

 

4.2 Updating the Slave Device 
Only follow the procedure described in this section the first time you start “Renesas_R-
IN32M3_EtherNetIP.project” in ¥an-r01an4281ej0100_rin32m3_ethernetip¥. 

 

4.2.1 Installing Device Information 
To use the EtherNet/IP slave device, you need to install the Electronic Data Sheet (EDS) file which contains 
information on the device. Use the file which is included in the stack. 

 

Select [Device Repository] from the [Tool] menu in CODESYS. 
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In the “Device Repository” dialog box, click on [Install]. A file dialog box will appear. Specify the EDS file 
“RIN32M3-EthernetIP-Adapter_R3.eds” in ¥an-r01an4281ej0100_rin32m3_ethernetip¥ R-
IN32M3_ETHERNETIP_sample¥devicedescription¥etnernetip. The result of installation will be indicated 
within the area in the blue frame in the figure below. The “ ” icon is displayed next to the result of a 
successful installation. 
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4.2.2 Updating the Devices 
 

(1) Updating the Device 

Right-click on “Device (CODESYS Control Win V3)” in the “Devices” tree, then select [Update Device…]. 

 

 

In the “Update Device” dialog box, select “CODESYS Control Win V3” under “PLCs”, “SoftMotion PLCs”, 
then click on the [Update Device] button. 
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(2) Updating the Ethernet Settings 

Right-click on “Ethernet (Ethernet)” in the “Devices” tree, then select [Update Device…]. 

 

 

In the “Update Device” dialog box, select “Ethernet” under “Fieldbusses”, “EtherNet/IP”, “Ethernet Adapter”, 
then click on the [Update Device] button. 
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(3) Updating the EtherNet/IP Scanner 

Right-click on “EtherNet_IP_Scanner (EtherNet_IP_Scanner)” in the “Devices” tree, then select [Update 
Device…]. 
 

 
 
In the “Update Device” dialog box, select “EtherNet/IP Scanner” under “Fieldbusses”, “EtherNet/IP”, 
“EtherNet/IP Scanner”, then click on the [Update Device] button. 
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(4) Updating EIPS_DEMO_RIN32M3 

Right-click on “EIPS_DEMO_RIN32M3 (EIPS_DEMO_RIN32M3)” in the “Devices” tree, then select [Update 
Device…]. 
 

 
In the “Update Device” dialog box, select “EIPS_DEMO_RIN32M3” under “Fieldbusses”, “EtherNet/IP”, 
“EtherNet/IP Remote Adapter”, then click on the [Update Device] button.  
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4.3 Connecting to the Software PLC 
This section describes the procedure for connecting to the target software PLC from the development 
environment via a gateway. 
 
 
4.3.1 Starting the Gateway Server 
Check the operating state of the gateway server in the system tray. If the server is stopped, click on the 
“ ” icon and select [Start Gateway] to start up the server. Usually, the server will be automatically started 
as a standard service when Windows is started. An icon in the system tray at the bottom-right corner of the 
desktop indicates the state of operation. 
 

 
 
 
Note: If you cannot find the icon in the system tray, start up the gateway server by selecting All Programs > 

3S CODESYS > CODESYS Gateway V3. 
If the icon still does not appear in the system tray, try rebooting your computer. 
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4.3.2 Starting the Software PLC 
Check the operating state of the software PLC in the system tray. If the software PLC is stopped, click on the 

“ ” icon and select [Start PLC] to start it. Usually, the software PLC will be automatically started as a 
standard service when Windows is started. An icon in the system tray at the bottom-right corner of the 
desktop indicates the state of operation. 
 

 
 
Note: If you cannot find the icon in the system tray, start up the gateway server by selecting All Programs > 

3S CODESYS > CODESYS Gateway V3. 
If the icon still does not appear in the system tray, try rebooting your computer. 

 

 

  



R-IN32M3 Series EtherNet/IP Transfer Procedure Startup Manual 

R01AN4281EJ0100  Rev.1.00  Page 19 of 34 
May. 25, 2018  

 

4.3.3 Setting up Connection with the Software PLC 
Double-click on “Device (CODESYS Control Win V3)” in the “Devices” tree. The “Communication Settings” 
pane will open. In this pane, you can make communications settings for connecting the software PLC service 
from your development environment. Click on the [Scan Network…] button on the “Communication Settings” 
tabbed page. 

 

 

 

The “Select Device” window appears and a search for available devices that can use the local network 
automatically starts. The search is successful if a software PLC service is found. Double-click on the PC 
name displayed. 

If the PC name is not displayed, re-check the settings described in sections 4.3.1, Starting the Gateway 
Server and 4.3.2, Starting the Software PLC. 

 

 

  

PC name (numerical value) will be 
displayed. 
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4.4 Network Settings for Devices 
 

4.4.1 Configuring the Host IP Address 
Before setting the devices, set the IP address of the host PC. Open “Network Settings”. 

In Windows 7, go to Control Panel -> Network and Sharing Center -> Change Adapter Settings. 

 

 

Double-click (or right-click) on Local Area Connection and select Properties. 
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Select “Internet Protocol Version 4 (TCP/IPv4)” and click on the [Properties] button. 

 

 

Select the IP address and subnet mask in the area indicated by the red frame in the figure below. 

 

 

You have now completed the settings. 
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4.4.2 Configuring the Ethernet Link 
Double-click on “Ethernet (Ethernet)” in the “Devices” tree to open the configuration window. 

On the “General” tabbed page, click on the icon next to the text box for “Interface” selection indicated by the 
red frame below to display the “Network Adapters” window. 

 

 

The names of connected ports will be displayed in the “Network Adapters” window. Select the port you will 
be using. 

 

 

Check whether the IP address of the selected port has been correctly set. 
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4.4.3 Configuring EtherNet_IP_Scanner 
You do not need to make settings for this device. 

 

4.4.4 Configuring EIPS_DEMO_RIN32M3 
Double-click on “EIPS_DEMO_RIN32M3 (EIPS_DEMO_RIN32M3)" in the “Devices” tree to open the 
configuration window. In this window, make settings on the “General” tabbed page. 

In EtherNet/IP, a slave device is identified by its IP address. Here, set the value of the IP address which has 
been set for the device. 
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4.5 Confirming the Connection with the Device 
This section describes the procedures for running a program in the CODESYS development environment 
and confirming connection of the device. 

 

Select [Build] from the [Build] menu. 

 

 

Select [Login] from the [Online] menu. 

 

 

Select [Start] from the [Debug] menu. The project will automatically start on Windows. 
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The state of connection will be indicated next to each device name. Successful connection is indicated by 
the " " icon as shown in the tree view below. 

 

 

The icons indicating the state of each device are listed below. 
: The PLC is connected and the application is running. 

 : The PLC is connected and the application is stopped. 
 : Error. Check the details of the error and the settings of the device. 
: The device information could not be found in the device repository. Recheck the device information file 

and reinstall the device. 
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4.6 Operations of CODESYS 
When CODESYS starts running, the following display will appear. The evaluation board receives the states 
of the switches in the following display and lights up the corresponding LEDs by transmitting the states of the 
switches as they are. 

 

 

The following shows the image when SW5 is turned on. 

 

 
 

Output: 0x10 (= bit 4 set to 1) 

Input: 0x10 (= bit 4 set to 1) 

CODESYS 
LED5 lights up when SW5 is turned on. 

LED5 on the evaluation board 
lights up. 

Zoom up 
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5. Documents for Reference 

 Documents, Application Notes, and Sample Code 
• R-IN32M3 Series Datasheet 
• R-IN32M3 Series User’s Manual: R-IN32M3-CL 
• R-IN32M3 Series User’s Manual: R-IN32M3-EC 
• R-IN32M3 Series User’s Manual: Peripheral Modules 
• R-IN, RZ/T1, EC-1, TPS-1 Groups Software PLC Guide: Configuring Projects and Creating User 

Interfaces 
• R-IN, RZ/T1 Groups Software PLC Guide: EtherNet/IP 
 
Download the latest version from the Renesas Electronics website. 
 

 
 Technical Updates and Technical News 

Download the latest version from the Renesas Electronics website. 
 
 Development Environment 

Download the latest versions from the websites of the respective companies. 
 
The latest version for the IAR integrated development environment (IAR Embedded Workbench® 
for Arm) is available from the IAR Systems website. 
 
The latest version for the software PLC (CODESYS) is available from the Linx website. 
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Appendix A  Changing the Configuration of the R-IN32M3-EC Evaluation Board 
By serially connecting the host PC and the R-IN32M3-EC evaluation board, the following settings can be 
changed through terminal software running on the host PC. 

 

Name Default Value 

Device Name dut 

IP Address 192.168.1.10 

Netmask 255.255.255.0 

Gateway 0.0.0.0 

MAC Address 74:90:50:f0:09:2e 

MAC Port1 74:90:50:f0:09:01 

MAC Port2 74:90:50:f0:09:02 

 

If the EtherNet/IP stack program had already been written to the R-IN32M3-EC evaluation board at the 
time the board was shipped so will run on the board, the above default values will have been written to 
the flash ROM. The initial values written to the flash ROM are given priority from the second startup. 
 

 

A-1 System Configuration 
The figure below shows the configuration of the system. 

 

Figure A.1 System Configuration 
 

  

Host PC 

Terminal Software 

R-IN32M3-EC Evaluation Board 

General USB 
mini-B cable 

USB Port R-IN32M3 

Serial 
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A-2 Changing the Configuration 
 

A-2-1 Connecting the R-IN32M3-EC Evaluation Board 
Follow the procedure below to connect the cables. 

(1) Connect the mini-B end of the general USB mini-B cable to the CN9 USB serial port connector to connect 
the host computer with the USB port on the evaluation board. 

(2) Connect an AC adapter with 5-V DC output to CN15 to supply power. 

 

 

A-2-2 Changing the Configuration 
 

(1) Starting the Terminal Software 

Start the terminal software and make settings for serial communications. The table below lists the settings for 
serial communications. 

 

Bit rate 115200 bps 

Data 8 bits 

Parity None 

Stop 1 bit 

Flow control None 

 

The following shows the settings for the line-feed codes of the terminal software. 
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(2) Resetting and Starting the R-IN32M3-EC Evaluation Board 

Press the reset button. This produces the following display. 

Before the count-down reaches 0, enter any number on the key board. 

 

To delete the flash ROM area, enter “y” for “Do you erase the flash area? (y/n):” and press Enter. Before the 
count-down reaches 0 again, enter any number on the keyboard. 

 

 

 

(3) Changing the Device Name 

To change the device name “dut”, enter “y” and press Enter. Otherwise, enter “n” and press Enter. 

 

 

 

(4) Changing the IP Address 

To change the IP address “192.168.1.10”, enter “y” and press Enter. Otherwise, enter “n” and press Enter. 

  

Press any key before counting reaches 0. 

Press any key before counting reaches 0. 

Overwrite this and enter “y” for 
“Are you sure?”, then press Enter. 

Overwrite this and enter “y” for 
“Are you sure?”, then press Enter. 
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(5) Changing the Netmask 

To change the netmask “255.255.255.0”, enter “y” and press Enter. Otherwise, enter “n” and press Enter. 

 

 

(6) Changing the Gateway 

To change the gateway “0.0.0.0”, enter “y” and press Enter. Otherwise, enter “n” and press Enter. 

 

 

(7) Changing the MAC Address 

To change the MAC address “74:90:50:f0:09:2e”, enter “y” and press Enter. Otherwise, enter “n” and press 
Enter. 

 

 

  

Overwrite this and enter “y” for 
“Are you sure?”, then press Enter. 

Overwrite this and enter “y” for 
“Are you sure?”, then press Enter. 

Overwrite this and enter “y” for 
“Are you sure?”, then press Enter. 
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(8) Changing MAC Port 1 

To change MAC port 1 “74:90:50:f0:09:01”, enter “y” and press Enter. Otherwise, enter “n” and press Enter. 

 

 

(9) Changing MAC Port 2 

To change MAC port 2 “74:90:50:f0:09:02”, enter “y” and press Enter. Otherwise, enter “n” and press Enter. 

 

 

(10) Writing to the Flash ROM 

If you have no problem with the changed settings, enter “y” and press Enter. If “Write data to flash!” appears, 
writing to the flash ROM has been completed successfully. If you want to change the settings again, enter “n” 
and press Enter. 

 

 

 

  

Overwrite this and enter “y” for 
“Are you sure?”, then press Enter. 

Overwrite this and enter “y” for 
“Are you sure?”, then press Enter. 

The changed settings are displayed. 

Writing to flash ROM has been 
completed successfully. 
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Appendix B  Notes on the Sample Program 
 

 Timeout 
The sample program is for evaluation and therefore has functionality for timeout if communications continue 
for more than 24 hours. If you want to release the timeout functionality, contact our partner Sherpa Inc. 
(https://www.sherpa-tech.net/). 

 

 Vendor ID 
The sample program is for evaluation and therefore uses the vendor ID owned by Renesas Electronics. If 
you want to use your own vendor ID, contact our partner Sherpa Inc. (https://www.sherpa-tech.net/). 
 

  

https://www.sherpa-tech.net/
https://www.sherpa-tech.net/
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Website and Support 
Renesas Electronics Website 

http://www.renesas.com/ 
 
Inquiries 

http://www.renesas.com/contact/ 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
All trademarks and registered trademarks are the property of their respective owners. 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller Unit Products 
 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from 
Renesas. For detailed usage notes on the products covered by this document, refer to the relevant sections 
of the document as well as any technical updates that have been issued for the products. 
 

1.  Handling of Unused Pins 
Handle unused pins in accordance with the directions given under Handling of Unused Pins in the 
manual. 
 The input pins of CMOS products are generally in the high-impedance state. In operation with 

an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 
LSI, an associated shoot-through current flows internally, and malfunctions occur due to the 
false recognition of the pin state as an input signal become possible. Unused pins should be 
handled as described under Handling of Unused Pins in the manual. 

2.  Processing at Power-on 
The state of the product is undefined at the moment when power is supplied. 
 The states of internal circuits in the LSI are indeterminate and the states of register settings 

and pins are undefined at the moment when power is supplied. 
In a finished product where the reset signal is applied to the external reset pin, the states of 
pins are not guaranteed from the moment when power is supplied until the reset process is 
completed. 
In a similar way, the states of pins in a product that is reset by an on-chip power-on reset 
function are not guaranteed from the moment when power is supplied until the power reaches 
the level at which resetting has been specified. 

3.  Prohibition of Access to Reserved Addresses 
Access to reserved addresses is prohibited. 
 The reserved addresses are provided for the possible future expansion of functions. Do not 

access these addresses; the correct operation of LSI is not guaranteed if they are accessed. 
4.  Clock Signals 

After applying a reset, only release the reset line after the operating clock signal has become 
stable. When switching the clock signal during program execution, wait until the target clock signal 
has stabilized. 
 When the clock signal is generated with an external resonator (or from an external oscillator) 

during a reset, ensure that the reset line is only released after full stabilization of the clock 
signal. Moreover, when switching to a clock signal produced with an external resonator (or by 
an external oscillator) while program execution is in progress, wait until the target clock signal 
is stable. 

5.  Differences between Products 
Before changing from one product to another, i.e. to a product with a different part number, confirm 
that the change will not lead to problems. 
 The characteristics of Microprocessing unit or Microcontroller unit products in the same group 

but having a different part number may differ in terms of the internal memory capacity, layout 
pattern, and other factors, which can affect the ranges of electrical characteristics, such as 
characteristic values, operating margins, immunity to noise, and amount of radiated noise. 
When changing to a product with a different part number, implement a system-evaluation test 
for the given product. 

 
 

  



 

 

• Arm and Cortex are registered trademarks of Arm Limited (or its subsidiaries) in the EU and other 
countries. All rights reserved. 

• Ethernet is a registered trademark of Fuji Zerox Limited. 

• TRON is an acronym from "The Real-time Operating System Nucleus". 

• ITRON is an abbreviation of "Industrial TRON". 

• μITRON is an abbreviation of "Micro Industrial TRON". 

• TRON, ITRON, and µITRON do not refer to any specific product or products. 

• EtherNet/IP is a trademark of ODVA. 

• CODESYS is a trademark or registered trademark of 3S-Smart Software Solutions GmbH. 

• All other product names and service names in this document are trademarks or registered trademarks 
of their respective owners. 
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Notice
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products and application examples. You are fully responsible for

the incorporation or any other use of the circuits, software, and information in the design of your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by

you or third parties arising from the use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or other intellectual property rights of third parties, by or

arising from the use of Renesas Electronics products or technical information described in this document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application

examples.

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or others.

4. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any and all liability for any losses or damages incurred by

you or third parties arising from such alteration, modification, copying or reverse engineering.

5. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for each Renesas Electronics product depends on the

product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home electronic appliances; machine tools; personal electronic

equipment; industrial robots; etc.

"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products are

not intended or authorized for use in products or systems that may pose a direct threat to human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause

serious property damage (space system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims any and all

liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is inconsistent with any Renesas Electronics data sheet, user’s manual or

other Renesas Electronics document.

6. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for Handling and Using Semiconductor Devices” in the

reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation

characteristics, installation, etc. Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such specified

ranges.

7. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific characteristics, such as the occurrence of failure at a

certain rate and malfunctions under certain use conditions. Unless designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas

Electronics document, Renesas Electronics products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury, injury

or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety design for hardware and software, including but not limited to

redundancy, fire control and malfunction prevention, appropriate treatment for aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult

and impractical, you are responsible for evaluating the safety of the final products or systems manufactured by you.

8. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas Electronics product. You are responsible for carefully and

sufficiently investigating applicable laws and regulations that regulate the inclusion or use of controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics

products in compliance with all these applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance with applicable

laws and regulations.

9. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is prohibited under any applicable domestic or foreign laws

or regulations. You shall comply with any applicable export control laws and regulations promulgated and administered by the governments of any countries asserting jurisdiction over the parties or

transactions.

10. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or transfers the product to a third party, to notify such third

party in advance of the contents and conditions set forth in this document.

11. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

12. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas Electronics products.

(Note 1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled subsidiaries.

(Note 2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.
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